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Chapter 1 - Introduction


Welcome to Guide to Tracktion T7. The goal of this book is to help you learn T7. If you are coming to T7 from another DAW or learning computer recording from the ground up, you will find this guide useful. This book will be particularly interesting to those who already have experience with the Tracktion DAW. Tracktion T7 has dozens of new and innovative features. This latest version streamlines the workflow while making the software more powerful than ever.


T7 runs on both Mac and PC including 64-bit versions of OS X and Windows. T7 is also one of the top mainstream DAWs that runs on Linux. All versions are maintained in parallel so the latest revision is almost identical across platforms.


T7 like its predecessors is unique in that it has a one screen user interface with a mixer channel integrated to the right of each track. There is no separate console view so you never need to flip back and forth between a track view and mixer view. This concept was pioneered with T1 more than a decade ago and seems modern even today.


T7 has a very flexible plugin architecture that includes native plugins, plugin racks, and third party plugins supporting VST, VST3 and AU.


What’s New in Tracktion T7


Tracktion T7 has many new and exciting features. They both enhance the workflow and open up new creative potential. These changes have or will be incorporated into this new edition of the book. For a more in-depth look at the new features, jump to Chapter 38 - New in Tracktion T7.



  	New UI Style and Color Schemes

  	Clip Layer Effects

  	Track LFOs

  	New Compact Transport Bar

  	Visual Plugin Selector

  	Quick Zoom

  	Easy Sidechaining for Plugins

  	Grouped Clips

  	Linked Clips

  	Three Column Projects Tab

  	Right-side Browser Option

  	Automation Patterns

  	Plugin Racks Side Panels

  	Automatically Hide Panels

  	First Run Tasks

  	Automatic Edit Preview Rendering

  	Integration with CloudBounce Mastering




What’s in the Book?


In this book you will learn:



  	How to install and set up T7

  	How to record audio to tracks 

  	How to record MIDI and use virtual instruments 

  	How to record with guitar amp simulators 

  	How to edit audio 

  	How to edit MIDI 

  	How to mix with the inline mixer section 

  	How to insert and use plugin effects 

  	How to mix down to Wave or MP3 files





    Tip: I encourage you to go to the Tracktion website and make sure that your installation of T7 is fully up-to-date.




Also, check out the Book Extras. You will find a keyboard shortcut cheat-sheet that you can print and reference. 


What’s Not Covered in this Book?


Tracktion T7 is often promoted as an easy to use DAW. That tends to be true once you get the hang of it. But the more you learn, the more you realize how deep the feature set really is. I never really intended to write a manual for Tracktion. However, for lack of a manual, this book serves that function for many Tracktioneers. To be honest up front, I have this list of things not covered in the book. This list might not be comprehensive, but these are the big ones:



  	In depth coverage about Plugin Racks

  	Using multi-output Synths

  	Control Surface Mapping

  	Tracktion Sampler

  	Video integration

  	Melodyne ARA

  	Project Templates

  	Tracktion Archive format

  	CPU Usage Meter




Many of the above topics are addressed in the videos at Groove3.com, on the Tracktion website, or my YouTube channel. If this book is successful, some of these topics might make it to a future edition or a follow-up book on advanced topics. Remember to subscribe to my YouTube channel so you know when new Tracktion content is added.


I don’t attempt to cover fundamentals of recording like mic selection, recording technique, or the broad topics of mixing and mastering. There are plenty of other resources for that. This book is focused on how to operate Tracktion T7.


Tracktion Videos


I have also produced video series covering all the majority of new features in T7 that has been published by Groove3.com titled Tracktion T7 Update Explained. The video series is 1 hour and 15 minutes of live walkthroughs of the new features covered in Chapters 38 through 41 of this book.


In conjunction with the first edition of this book, I produced a series of free videos that detailed new features in Tracktion T6. You can find those on my website BillEdstrom.com.


I also produced a full Tracktion video tutorial video series - Tracktion 5 Explained. Many of these videos are available for free on the Tracktion videos page.


The full series is available for purchase and download at Groove 3, Inc.


For in-depth coverage of the plugin racks feature, check out Tracktion Plugin Racks Explained also from Groove 3.


While the Groove 3 videos were produced for Tracktion T5, you will find the core workflows are still relevant. This book along with the videos mentioned above are your best companion as you learn Tracktion T7.


Setting Tracktion Keyboard Shortcuts


This book uses an alternative keyboard shortcut layout that you will need to turn on to follow the examples. To do that follow these steps:



  	Navigate to the Settings tab, Keyboard Shortcuts page 

  	Click Reset to Defaults at the bottom of the page 

  	Select Use alternative Tracktion key-mappings
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  Settings Tab: Set the Keyboard Shortcuts to Match this Book



This set of keyboard shortcuts was carefully designed for efficient workflow and keeps the commands consistent between Mac and Windows. You may download printable keyboard templates and cheatsheet PDFs for the alternative key-mapping from the Leanpub store where you purchased this book.


Is Tracktion the Software or the Company?


Tracktion Software Corporation (TSC) is “Tracktion.” The DAW Software that Tracktion has published are T4, T5, T6, and T7. So, the proper way to refer to the DAW software is either “T7” or “Tracktion T7.” 


While I am aware of that, I still tend to call the software “Tracktion.” You will find a mix of T7, Tracktion T7, and Tracktion used in this book. In any of those cases I am referring to the Tracktion DAW software.


Modifier Keys Conventions


The book uses the following abbreviations for modifier keys:



  	Command - Cmd

  	Control - Ctrl

  	Option - Opt

  	Alt - Alt




In most cases Cmd on Mac will translate to Ctrl on Windows. For the book, I present both using the convention Mac / PC like this: Cmd + C / Ctrl + C.



  	Here is another example:

  	Click to select the clip then copy it using Cmd + C / Ctrl + C. Next, position the cursor in the Arrangement where you want to place the copy and paste it using Cmd + V / Ctrl + V.





    Note: Most Linux users will use the ‘Meta’ key in place of Alt. On a typical PC keyboard, Meta is usually the Windows key.




Assigning the Duplicate Command to the Keyboard


The Duplicate action is not mapped to the keyboard by default. To match the book examples, assign the ‘D’ key to duplicate. Here is how to do that:



  	Navigate to Settings tab, Keyboard shortcuts page 

  	Locate the Duplicate command. It’s in the Editing Functions section 

  	To the right of Duplicate, press the plus (+) icon 

  	The New key-mapping dialog box appears 

  	Press D key, then click OK







  [image: Mapping *Duplicate* to the D Key]
  Mapping Duplicate to the D Key



Moving On


With those things set, your T7 installation will match the examples in this book. Get ready to learn all about Tracktion T7!








Chapter 2 - Installing Tracktion T7


Most likely, you already installed T7. If you haven’t yet or have any questions about installation, keep reading.


Your Tracktion Account


Go to www.tracktion.com. Navigate to Account > My Account. If you haven’t yet purchased Tracktion, you can choose to download the demo or purchase a license. If you received a version of Tracktion when you purchased a mixer or audio interface, then you can upgrade at a nice discount. Regardless, create an account on the Tracktion site if you haven’t already done so.




  [image: Customer Login at Tracktion.com]
  Customer Login at Tracktion.com



After you log in, you will see your Tracktion licenses listed there. Click on My Downloadable Products and choose the version you want to install.




  [image: MyLicenses view in your Tracktion Account]
  MyLicenses view in your Tracktion Account



Should I Install 32-bit or 64-bit?


On the Tracktion site, navigate to Account > Downloads. That opens a set of tabs where you can choose which version to download - 32-bit or 64-bit. 


The sound quality is the same between the 32-bit and 64-bit versions of T7. The decision is about compatibility with your computer and plugins.


Tracktion T7 32-bit:



  	Runs on either 32-bit or 64-bit operating systems

  	Runs only 32-bit plugins

  	Can access up to 4 GB of RAM




Tracktion T7 64-bit:



  	Runs on ONLY 64-bit operating systems

  	Runs only 64-bit plugins

  	Can access more than 4 GB of RAM




The key point here is this. If you want to run older 32-bit plugins use the 32-bit installation of T7. If your computer has more than 4GB of RAM, then running the 64-bit version allows you to load more instances of large virtual instruments. For the examples in the book, I am running the 64-bit version.



    Warning: If you use the 64-bit version, T7 will not recognize your 32-bit plugins. If you rely on 32-bit plugins, then stick with the 32-bit version of Tracktion.




Click on correct link to download the installer. This happens fast because the installer is only a bit over 10 MB which is pretty amazing!


The installation varies slightly between Mac and Windows so I will walk through both.


Mac OS X Installation


The installation file on Mac has a .dmg file extension. This is typical of most Mac installers. Double-click the file to open the disk image. You will see the T7 app right there.


Drag T7 to the applications folder which is conveniently aliased right next to it. That’s it, Tracktion T7 is installed. You still need to unlock it and we will get to that shortly. 


Windows Installation


The installation file on Windows has a .exe file extension. This is typical of most Windows installers. Double-click the file to start the installation wizard. Step through the wizard to tell Tracktion where you want it to be installed. In most cases the defaults will work best. In flash it’s done.


Linux Installation


To date, I haven’t run T7 under Linux personally. The great thing is that current Linux builds are available and reportedly work very well. 


There is a separate Linux section on the Accounts > Download page on the Tracktion website. There you will find the latest 64-bit build in the form of a Debian package (.deb). If you are running Ubuntu, you can just download the file and double click and install the package. 



    Note: If you are experienced with Linux and would like me to add more here, send me a note!




For more about running T7 on Linux, the best source I have found is the Tracktion Linux FAQ on KVR.


Running Tracktion for the First Time


To launch T7 on Mac, locate Tracktion in the applications folder and double click the icon. Another way is to type of few letters of of the word ‘Tracktion’ into Spotlight and select it from the search results.


In Windows, find T7 in the Start Menu. In either case, launch it and T7 will start up. The T7 window initially has two tabs - Projects and Settings. Later your songs, called ‘Edits’ in Tracktion, will load into additional tabs.


Tracktion T7 initially runs in demo mode. If you have a license  it is quick and easy to unlock it:
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  The Unlock Button on the About Box




  	Select the Help > About menu item at the lower left of the Projects tab. This loads the About box. You will see all kinds of information about T7. 

  	Locate and click the Unlock button. 

  	Enter the address and password you used when registering at the Tracktion website and click Register.  




Tracktion T7 is now unlocked and ready to use on this computer.


Pop-up Help


As you start exploring T7, you will soon notice pop-up help. Pop-up help balloons appear as you move the mouse pointer over objects on the window. While somewhat helpful, these messages are also pretty annoying. I suggest turning pop-up help off. To do that, click Help > Turn off pop-up help. The help button is located in the lower left corner of the Projects tab. You can easily reverse that if you want pop-up help back. 



    Tip: If you ever want to see pop-up help with it disabled, point to the thing you’re interested in and hit F1. 





    Note: At the time of writing, the pop-up help messages had not been updated for a while. They might be incomplete or inaccurate. 




Installing Melodyne Essential


Melodyne Essential is a terrific bonus for T7 users. It adds powerful pitch and time manipulation to T7 at no addition cost. Melodyne Essential is a separate installation and is provided under license from Celemony. Here are the basic steps to install and active it.



  	Exit T7 if it is running

  	Go to the Tracktion website and log in (Account > My Account)

  	On your Account Page copy or make note of the Celemony - Melodyne Essential license code listed there (Account > MyAccount)

  	Go to the Celemony website then click login. Log in or create a new account.

  	Follow the website instruction to register Melodyne Essential, download it, and install it.





    Tip: Make sure to install Melodyne using its installer defaults. Tracktion T7 is integrated with the ARA technology of Melodyne and should detected it on the next restart.





    Note: T7 also works with the full Melodyne Editor. If you already have that on your system, just check to make sure it is the latest version.





    Note: Melodyne is not available for Linux or the Linux version of T7. 




For more information on getting Melodyne Essential up and running check out TSC’s Melodyne Configuration Tips & Tricks page. 


Moving On


At some point you will want to scan your existing plugins and loop library. You can learn how to do that in Chapter 22 if you want to work ahead. However, that’s not necessary quite yet. Let’s move on to installing the demo Projects.








Chapter 3 - Installing the Demo Projects


This chapter simply walks through the process of installing the Tracktion demo songs. The demos are cool because they give you something to experiment with as you learn the basics.


Establish a Tracktion Projects Folder


It’s a good idea decide where you want to keep your Tracktion projects on your system. I keep mine together on a separate external drive I use for music projects. I store all my Tracktion projects in a folder named ‘Tracktion.’ This makes it easy to find my projects and easy to back up. 


It is also reasonable to create your Tracktion folder under the Documents folder on your system. So, decide on a location and create your Tracktion folder using Finder (Mac) or File Explorer (PC).


Project Tab - Get Demo Songs


The Menu at the lower left of the Project tab includes a button - Get Demo Songs. Click that for a quick way to download the demos.
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  Get Demo Songs Button 





  [image: Get Demo Songs Dialog Box]
  Get Demo Songs Dialog Box



Select the songs to download from the list, choose the destination folder then click Download. I suggest using your newly created Tracktion project folder as the destination. You also have the option to show only new songs meaning those you haven’t yet downloaded.


Demo song downloading will be handled in the background. You can use the Progress Meter in the upper right corner to see how the downloads are progressing.




  [image: Checking the Progress of Demo Downloads]
  Checking the Progress of Demo Downloads



When the downloads are finished, the demo songs will appear at the bottom of your Active Projects. 



    Tip: I like to reorganize the demos into a folder to keep them separate from my own projects.






  [image: Demo Songs in a Folder]
  Demo Songs in a Folder



Moving On


With Tracktion installed and a few demo files ready to play with, it’s time to move on to configuring your audio interface. That’s up next.








Chapter 4 - Audio Device Setup


To use Tracktion, it is essential to configure it to work with your audio interface. While Tracktion does work with internal audio, most users will use an external audio interface. Tracktion supports Core Audio on Mac. Tracktion supports ASIO and Windows Sound (WASAPI) on PCs.




  [image: Audio Device Page]
  Audio Device Page




    Warning: To configure Tracktion for recording you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in alignment with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup. The procedure to do this is covered in this chapter.




This chapter covers the essential steps to get your audio interface configured as an audio device in Tracktion. The steps are simple and important so you can hear playback.


Audio Device Setup Setup on Mac


Here is how this works in OS X. 



  	Click on the Settings tab then select the Audio Devices page.

  	Select an output Device. Assuming you have necessary drivers installed and the device hooked up, it should appear as an option for the Output: property.






  [image: Mac - Audio Device Output and Input Properties]
  Mac - Audio Device Output and Input Properties




    Note: With OS X, USB audio interfaces that follow USB Audio Class 1 (1998) or USB Audio Class 2 (2009) will function without installing any additional driver. In the product specs for such devices they often list “class compliant.”





  	Select an Input device





    Tip: I strongly suggest that you select the same device for the output and the input. In this example I’m using a USB iTwo which is a simple 2 in / 2 out interface.





    Note: On OS X, you can select the input device and output device separately.






  [image: Audio Device *Test* Button on Mac]
  Audio Device Test Button on Mac




  	Test Button

  	There is a convenient Test button next to the audio device parameter. Click it, to send a short test tone to the output. If you hear the tone you are pretty much good to go at this point.




Audio Device Setup in Windows


This is a walkthrough of the audio device settings for Windows. If you haven’t already, navigate to Settings tab > Audio Devices page.



  	Audio Device Type

  	Tracktion gives Windows users four choices for audio device type.





  	Windows Audio

  	Windows Audio (Exclusive)

  	DirectSound

  	ASIO
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  Windows Audio Device Types



So which to choose? Any of them might work with your computer but there are definite differences and best choices here.



  	ASIO

  	This is the best choice if you are using an external audio interface. You will need to install the manufacturer’s driver. The good news is will usually give you the best low latency performance for recording and playback. Many modern audio interfaces include a mixer app to control low latency mixing within the unit. When using ASIO, you just choose the device and it is set for both inputs and outputs.

  	Windows Audio

  	Use this if running Windows Vista/7/9/10 on your computer and using the internal sound on your machine. Great for using a laptop directly while traveling. This device type uses WASAPI (Windows Audio Session API) which offers nicely optimized access from applications software to audio I/O. Windows Audio will also function with USB Audio Class 1 interfaces.

  	Windows Audio (Exclusive Mode)

  	This is the same as Windows Audio but Tracktion will not allow any other application to use the audio interface while running. For the lowest latency and most critical applications choose this when using your internal sound.





    Note: As of this writing, no version of Windows supports USB Audio Class 2 devices natively - not even Windows 10. This applies to most USB2 or USB3 interfaces. They might function okay because they usually default back to USB Audio Class 1. For best performance, install the manufacturer’s drivers and use ASIO if possible.





  	DirectSound

  	Choose this when using Windows XP with your internal sound. This is not a good choice for Windows Vista/7/8/10. For Windows 8 and 10, it is deprecated and might not work at all.





    Tip: If you aren’t on Windows XP don’t use the DirectSound device type.




Choosing the Audio Interface


With the audio device type set, you can choose any audio interface connected to your computer or the internal sound. Select your device if it’s not already shown for the Device: property.




  [image: ASIO Device Setup on Windows]
  ASIO Device Setup on Windows




  	Control Panel

  	On some but not all audio interfaces, clicking the Control panel button will open the manufacturer’s driver control panel to set the buffer size. Many audio interfaces don’t allow you to set the buffer size or the sample rate through host software. If that is the case, locate the control panel software on your system, and open it. Set the Sample Rate and Audio buffer size there. In some cases, you will need to restart Tracktion for the change to take effect.




Setting the Sample Rate


The default for the sample rate is 44100 Hz which matches the sample rate for CDs. I would suggest choosing that unless you have a reason to choose a different sample rate.




  [image: Setting the Sample Rate]
  Setting the Sample Rate



Testing for Audio Playback


It is a good idea to test playback to make sure you get sound and a full stereo image. Here is one way to do that:




  [image: Loading the SubWays Demo]
  Loading the SubWays Demo




  	Go back to the Projects tab and select one of the demo tunes - Subways is a good choice. 

  	Locate the Edit on the right (SubWays T4) and double-click to open it. 

  	Click Play (spacebar) and you should hear music!






  [image: Successful Play Back]
  Successful Play Back



About Latency


The process of mixing your tracks together, calculating digital effects, and triggering instrument samples takes time in any DAW. It is impossible for digital mixing to happen instantly. The amount of time your computer needs to compute, process, mix and playback from input to output is called ‘latency.’ Latency is the amount of time you allow the computer think and is normally measured in milliseconds - from just a few to several hundred milliseconds.


During playback, latency is detected only as a delay between hitting play and hearing playback. This results in a barely detectible lag in the transport functions and doesn’t cause much trouble.


Latency during overdubbing is more of an issue. If you are hearing playback of existing tracks a bit late, then what you are recording is not going line up correctly because your timing reference is shifted - late or early. Even a few milliseconds will effect feel. At 30 or 60 milliseconds, the timing will seem off. This can have an impact on the feel of the recording or even make it the timing seem completely off.


For these reasons, DAWs have latency compensation. Following recording, the audio tracks are essentially shifted to compensate for latency in the A/D process, mixing, and plugin DSP processing.


Managing Latency


Audio buffer size by default is 512 samples (11.6 ms) on OS X and 256 samples (5.8 ms) on Windows. On modern Mac computers, you can usually run with the buffer size set to 256 as well.



    Note: The choice of buffer size options available varies. It depends on what what audio interface, connection type, and driver technology.  




Let’s consider a latency of  11 ms. In reality, 11 ms is a very short period of time. In the real world if you are playing a MIDI controller into a virtual instrument, there will be an 11 ms lag between when you play a note and when you hear the note. It’s the same thing if you’re working with a virtual guitar amp or amp simulator. When you play a note the guitar you hear the sound 11 ms later. Sound travels through air at the rate of approximately one foot (0.34 meters) per millisecond. So this latency is like playing with your guitar amp or keyboard monitor 11 feet (3.4 meters) away. There is a delay but you might get by. At 6 ms delay, usually the delay is barely noticeable. 


With computer recording, we alway aim to strike a balance between noticeable latency and getting clean playback. Why not just lower it all the way down? Because, the computer needs time to ‘think’ and produce the sounds and process effects. If we get too aggressive with lowering the buffer, the computer starts to complain in the form of pops, clicks, dropouts, and the like. So during recording you might keep this lower, during editing and mixing you can increase it.



    Tip: Try 256 samples when you get started. While your songs are simple, this should work fine on most modern systems. If you feel there is to much delay when playing virtual instruments, try even lower. If the audio starts to break up, try higher settings.





    Note: When using Melodyne Essential for editing audio, you will need to increase the buffer size to at least 1024 samples to prevent getting a warning message and to have clean playback.




Calibrating Input Latency Compensation


If you use Tracktion for any overdubbing, this is possibly the most important lesson in this book. Tracktion requires you to run Auto-Detect using a loopback connection on your audio interface.



    Warning: This test sets up up a deliberate feedback loop. Switch your speakers off during this test.You will be connecting an output to an input using a patch cord so be careful.




Here are the steps:



  	Turn off your monitor speakers!

  	Make sure any input monitoring knobs, buttons, or mixers or off or turned down.

  	Connect one output back to one of the inputs. To make it simple, connect the left output to input one.

  	Turn the gain up about half way on the input.

  	In Tracktion go to Settings > Audio Devices.


  	In the Channels list click on one of the Inputs






  [image: Select an Input]
  Select an Input




  	In the Properties section click Auto-Detect.







  [image: *Auto-Detect* & *Time Adjust* Parameters]
  Auto-Detect & Time Adjust Parameters




  	Click Run Test. Tracktion will send a short test signal from the output to the input. It will calculate the delay between output and input.






  [image: Recording Synch Test Dialog Box]
  Recording Synch Test Dialog Box




  	Click Apply and Traction will copy the delay value to the Time Adjust property.






  [image: Applying the Auto-Detect Result to *Time Adjust*]
  Applying the Auto-Detect Result to Time Adjust



For recordings to be aligned during overdubs, you must repeat this every time you make a change to the Sample rate or Audio buffer size. If you don’t, your recordings will be several milliseconds out of alignment with existing tracks.



    Tip: You can keep a note of the Time Adjust values at different settings an enter it manually for the settings you commonly use.





    Warning: To configure Tracktion for recording you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in alignment with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup. 




Other Audio Device Settings


We just covered the essential things to get going. There are more settings here that you might be curious about. To be complete, here is an explanation of each!
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  Other Audio Device Settings




  	CPU Cores to Use

  	This can be set from one to the number available. Usually you leave this at the maximum cores available. The maximum is typically the number of hardware cores in your CPU times two. For example, if you run a four-core processor, the maximum cores will be reported as eight. If you are running some other software alongside Tracktion that needs more CPU power, then you can reduce this number to make Tracktion leave some cores open for other tasks CPU. Cases where this is necessary are rare except when debugging specific problems.

  	Use 64-bit Maths When mixing Tracks

  	I normally leave this on. If you have a nice fast computer you can leave that on. It gives you a little bit more headroom in the mix engine. You probably won’t notice much difference if it’s on or off. If you have a very old computer with limited CPU, leave it off. By default it’s off; I usually leave 64-bit maths turned on.

  	Only Show Enabled Devices

  	The Channels list on the Audio Devices page includes a check mark next to each input and output. Click that check mark and it turns to a red ‘X.’ This disables that hardware and after that Tracktion will no longer present it an option in other menus. Well, this setting Only Show Enabled Devices will hide disabled inputs or outputs when turned on. I usually leave it off.

  	Max Monitoring Latency

  	This is the maximum allowed latency when in low latency monitoring mode. If latency exceeds this, Tracktion will shut off some plugins. I suggest you leave this at the default 5 ms and don’t worry about it. It has no effect unless you engage low latency mode.

  	Low Latency Buffer Size

  	This is the alternative buffer size to use when in low latency mode. Leave this at the default and don’t worry about. It also has no effect unless you engage low latency mode.





    Tip: If you are curious about low latency mode, click the ‘i’ next to the Max Monitoring Latency or Low Latency Buffer Size parameter. You enable low latency mode from the CPU usage window which is opened by clicking on the icon in the upper right corner of the Tracktion window header.
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  CPU Usage Meter Icon




  	Internal Buffer Multiplier

  	Another setting related to low latency mode. Usually just leave this set at 1X and forget it.




Resetting to the Defaults


If you are playing around with the values on this page and you just don’t know how they should be set, click  Reset Audio Settings.
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  Reset Audio Settings Dialog Box



Leave the page at the defaults and press OK. This resets the page to the factory settings. 


If you tick Reset input devices option, all the settings for input devices will get reset. Those include Input gain, Trigger level, Time adjust, and recording options.


If you tick Reset output devices then the output options are reset. Output options include Treat as stereo pair, Dithering Enabled, Left/Right Reversed and Alias parameters.


Moving On


Audio device setup is straightforward apart from running the Auto-Detect loopback test. Even so, you don’t need to fully understand everything on the Audio Devices page. Follow the guidelines in this chapter and you will be ready to move on!
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